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What’s New AL BN SE

» New Features

> v6.01
> v6.05

» Pending Features
» Coming Features
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New Features v6.01 QW& Goieel

1 CONMNECTING FEQPLE WITH TECHNOLOGY

» Sales Entry

» Emailing receipts

»  Setup > System Options > Email

» Setup > This Computer > Sales Entry > Ask customer if ..... email receipt
» No stock warning (Need to Special Order?)

» Setup > This Computer > Sales Entry > Show warning if stock level...

» User vs Clerk

1l Email Receipt? (]
Email: david@dds.com
Create a customer record with this email address \—(ES
Customer Mame
First: David No
Last or Company.  Johnson

URA West Palm Fall 20 I_THEU NIFORM
PR 1 ASOLUTION
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» New Features v6.01 & BAVOND

» Sales Table Enhancements

> Sort by Most Recent or Oldest
o Limit by Credit Card Number (last 4 with integrated processing)

o Limit by PO and Original Order Number
o “All Tab”

URA West Palm Fall'20
Diamond Data Systems, Inc.
What’s New in The Uniform Solution
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New Features v6.01 & BEVSNE

» User Activity Logging

- Log Tab - Sales, PO, Inventory —

> Setup > Users > Activity log e cex e

[E=1 Bl

_4 Changing Custorner (Baylor Plang) Acct No. 57 |

[1 General | 2 Notes | 3. Billing Information |[4. Sales & Taxes |[5. Ship To | 6. Credit Card & Contact | Z. W

Transaction Log

Date Time User Action

Show inactive

I Original Mame: Baylor Medical Center Mew Name: Baylor Plano I -

Selectimage

[] Setinactive

URA West Palm Fall 20 l_THEU NIFORM
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New Features v6.01 & BEVSNE

» Memorized Reporting
> How to Memorize Reports (and even copy them)
> Using Report Groups
o Multi-Stores and Memorized Reports

[ o=

Show:

1. Memarized |2 Completed 3. Savea|

E Memorized/Completed Reports

ki Fe-save Report

Dates WMemorized

Report Grou Report Description 5
" P ’ " Period Next Run Date Date User e TG
Monthly Reports Cash Flow Summary Last Month 8/01M16 to 83116 91716 |Owner F10-Process Group

Monthly Reports Max-Min Sales Analysis -Top 3 Last Month 8/01M16to /3116 91716 |Owner
Monthly Reports Top 40 ltems by Type - My Top 3 Vendors  Last Month 801160 8/3116 917116 |Owner
Monthly Reporis Vendor Comparison with Turns This Year to Date 10116 10 91716 917116 | Owner
Salesperson Reports Contract Sales Prev Year Comparison Last Month 8/01M16 to 83116 91716 Owner
Salesperson Reports Sales By Clerk Summary Last Month 8/01M6to 83116 91716 |Owner
Salesperson Reports Sales By Salesperson Summary Last Month 80116 to 83116 917116 | Owner

Memorized Reports W Group

URA West Palm Fall'20
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CONMNECTING FEQPLE WITH TECHNOLOGY

New Features v6.01 & syisnte

» Notes, Notes, Notes
» Unlimited secondary notes
» Use the F6 Notes button as usual - then add more
» Sales, PO, Rec, Customer :
2 Notes for (Invoice No. 112) ===

[ All Special Orders 1. Notes

Show: | By Number E‘ Primary:

LimitList = - -

Carda OE=cren The order has a special embroidery and hemming request - p—
PO. No. Delivery required  [7] Items with a balance

Order No:

1. Sales| 2 Special Orders |3 Layaways |4 Gift Cert 5. Quotes & Webstore | 7. Al

Order No Date Sold To Balance o
122 976 Renee Culbreath - Pickup 487 Secondary:
121 91716 Armando Chavez - Picku 0.00 "
’ Date Time Note User

119 91718 Armando Chavez (po 6522) - Pickup 3138

116 91716 Beth Allen - Pickup 26.85 917G 9:32AM Sentto hemming Owner

114 9M7/16 Brian Abbey - Pickup 30.31 91516 9:32AM Received back from embroidery owner

112| 91716 | B Cade Johnson- Pickup | 12843 | 91446 9:31AM Sentto embroidery owner

111 91118 Glen Estes (Baylor Plana) - Pickup 98.19

110 91116 Blake Burger - Pickup 8135

108 91118 Renee Culbreath - Pickup 56.57

106 9/05/16 Armando Chavez (Baylor Plano) - Pickup 62.79

) 101 9i0316 Blake Burger - Pickup 2327 [7] Show deleted

=
[] Show quantities

Diamond Data Systems, Inc.

URA West Palm Fall 20 l_THEUNIFORM
ASOLUTION
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New Features v6.01 & BEVSNE

» Training Mode (Activities > Enter Training/Demo Mode)

> Use your data for more realistic training

> Security is Active with Your Data
User security settings are used
Cannot print receipts
Sales Entry limited to 2 line items

f Y
Demo/Training Data Selection I“J

] What data would you like to use for the training session?

[ Demao Data

)

’ Use a backup copy of my data

URA West Palm Fall 20 . THEUNIFORM
PR 1 ASOLUTION
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i, DIAMOND

NeW Featu Fes VGO] WJ DATA SYSTEMS

» User SQL Queries

o Maintenance > SQL Queries

ili SQL Utilities

1. My Queries |2 System Queries "3 Run a Query

o[ -o-]

Description Date User
All Customer Caolumn Data - Save To C3V 304116
3104716/

Customers By Sales$ This Year - Save To CSV

4 ,\ Description:

Execute Query

[] Hide Progress

URA West Palm Fall 20 . THEUNIFORM
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I», DIAMOND

NeW Featu Fes VGO] W DATA SYSTEMS

» Catalog Standardization

o One Style Number for Reqular, Petite, and Tall
o Improved Detailed Descriptions

» Catalog Utility Enhancements
> Descriptions (short and detailed)

7 Changing Style (1066) el = =]
1. General |2 Wore | 3 Images |4 webstare
Style (All Colors) Detailed Description or Notes for Style OK
Vendor: | CHE Drawstring Pant
Style 1066
Desc: Pant Sizes for the Color shown with all possible Sizes for the Style
Depart Size Sot  Cost Retal  *
All colors are the same price HKS 0 14.50 29.00 U
[T] All sizes are the same price HASP 0 14.50 29.00
Cost pes) 1 14.50 29.00
Retail: Level | 173 XSP 1 14.50 29.00
Current Color and Code ST 1 15.50 31.00
Vendor Provided
Color: 3 Color(s) ] 2 14.50 29.00
Code:  REORD ¢ = 2 14.50 20.00
<4 \_| 3
[¥] Include in WebStor An’ ¥ indicates the size is NOT available in the color

=
Or
—C
C<
=
O
A
2=

URA West Palm Fall'20
Diamond Data Systems, Inc.
What’s New in The Uniform Solution
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New Features v6.01 & BEVSNE

» Style Comparison Report
» Reports > Sales > Style Comparison Report

» Invoice Receipt Totals
» Contracts

» Assign Contracts to Salesperson

» Contract Performance Reports

» Contract Sales Previous Year Comparison
» Sales by Contract Report

» Any Date Range

»  Group by Salesperson

URA West Palm Fall 20 . THEUNIFORM
PR 1 MSOLUTION
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URA West Palm Fall:20
Diamond Data Systems, Inc.
What’s New in The Uniform Solution

y, DIAMOND

New Features v6.01 & Davong

» EMV Credit/Debit Card Processing

Full EMV Compliance
Signature Capture (no signed receipt to keep and track)
Customer Can Choose Credit/Debit

Integrated Processors O~ openedge
» Open Edge (X—Chal‘ge) w A division of globalpayments

www.openedgepayment.com

» ChargeltPro Credit Card Processing -// ChargeItPro

http://info.chargeitpro.com/TheUniformSolution

ChargeltPro

10/3/2016
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New Features v6.01 QW& Gieel

CONMNECTING FEQPLE WITH TECHNOLOGY

» Maintenance Features
> Automatic Program Downloads (Setup > System Options)
> Backup Folder Location (same path from all stations)
- Required Program Updates (Catalog, EDI, etc..)

* Changing System Options EI =] @

1. General |2. Inventory"g. More "4 Country"ﬁ. Email ][g Professional]

Options

Use the system security and logon options Cancel

i

Show all dates with a 2 digit year where possible

Automatically download program updates (Last checked 9/M17/16)

Do not download updates if required for all polling locations

Backup Options

Automatically backup the program’s data files on startup Copies: | 10 =

Specify the backup folder

LI\ F OWEREDGET 110\Backups (=]

Close Accounting Period (prevent changes to sales, payments, and receiving lists)

@ Mever () Endoftheday () Endofthe month ) End ofthe year

URA West Palm Fall 20 . THEUNIFORM
PR 1 ASOLUTION
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New Features v6.05 &8 DronR

» Following Directions Prison Break in Guardians of the Galaxy

» Enhanced Ul - Font Size Options
(Setup > This Computer)

. Changing Computer Settings (Station Number 1) \EI = @

botution SGL Server - Virsion 2016-6.05 OB AC1A - Uniforms USA (Owner) ** Developer Mode ** =_E=)
1. General ‘z. Hardware“;. Credit Cards“g Sales Entry”é. Smppmg}ﬁ. Wisc ks Actraties Repots Setup Mamtenance Window  Help |

Ease of Use Settings oK _'_r_ m ‘ E ) E‘I R |
Cust PO

] L nem Hecene Tags Orgers Clock  WebStone
Play sound effects in the program: Play” ready-to-scan
frders | )
Pressing ENTER moves to the nextfield on forms . ; .
o el | D Fa-Total
Always maximize screens on open .
(] ] past oue aue [ FsPaymant
[7] Use the simple point-of-sale screen () [ Deleoryracuicsd [P posna with a balance =
= Fé-Hiotes
lel = =
" " r = Er-oner Detan
FontSize:  Medium (Recommeded) E‘ “*activates on restart pecial Orders | 3, Layaways | 4. Gt Cert | 5 Cuotes | 5 WeesStors |7 A - o
& Fa-Oeivening
General SemngS 0 Date SolaTo Balance Total [ L Fapint
[] Require a user to re-lagin before starting or madifying a sales entry item m il | L y AR Z271 Fi0-Fax |
121 NG Amands Chaver - Fickup 0.00 7578
Require new invoices to be printed WG Amands Chavez (pe 6522) - Pickup 3139 nw
X . WG Bath Allen - Pickup 2645 3356
llow inventory costs on the inventory list to be displayed wIHs Grian Abey - Pickup 3031 3768
Show change due in a message box after tendering payments 112 an1Hs Cace Johason - Ficiup 12843 14343
111 anns Glen Estes ([Baytor Pland) - Prckup 2819 12319
) aning Blaks Burger - Pickup 8135
anns Renes Culbiath - Picisp 5 6857
0% W0ans Armando Chavez (Baylor Plang) - Picug 279 62719 |
= Show cidest Srst
(P | e Show deleled
! . | N Show quantibes t
| |E1 AN Special Onders 4 Fx |
Webfitore-Mobile : Ready Users 112 Saturday, September 17, 2016 123314 PM

o west paim 20T ~ [[jIHEUNIEORM
iamond Data Systems, Inc. -IS o L U T I O N 14
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New Features v6.05 & Dayonn

» Rollup Billing
» Setup a single “Billed” account to receive invoices from multiple
store accounts
» Activate on Customer Form Billing Tab
» Reports
» Account Statements for “All Customers” are only created for the Rollup Account

» Account Statement for a single Rollup Account can be run individually
» A Summary Invoice includes all store accounts

+* Changing Customer (Baylor Planc) Acct No. 5T Billed To (Baylor Texas) | B [

" 4 Sales & Taxes | 3 ShipTo § Credit Card & Contact [ WebSlore § Log

. i |
speoalordectems] | L 2

1 General | g Notes| 3 Rilling

AltAg N Defaull PO No

! Migw sub-accounts to b added 1o this customer

Credi Beavictions
Hone @& Credit Limil Allowance Ho Credil Amount: 2.500.00 Terms Limit a0

T

URA West Palm Fall'20

Diamond Data Systems, Inc. I IS 0
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DIAMOND

New Features v6.05 & BavonD

CONMNECTING FEQPLE WITH TECHNOLOGY

» Receiving Payments on Account

» Specify a Rollup Account

» Consolidate or rollup sub-account invoices into a single amount
due line item (Rollup Transactions checkbox)

=]

i

[5% Adding Payment (New) - Acct No.65

PaymentAction
.
@ Payment () Paid Out Apply Credits Date 9716 B
Customer: Baylor Texas Ay Amount
Only lookup billed accounts Paid By Cash E
MNotes: RefNo.
Transactions with Balances to Show
_ _ _ _ _ F2-Auto Apply
@ Sales () Special Orders () Layaways () Gift Cerlificates ) All ltems
(Paymentto apply to the selected transaction) [ Payment [ 9 F4ClearAl l
Date Type RefNo. Sold To Total Amt Due Payment
8/28/16 Invaice Multiple | Chavez, Armando (Baylor Plano) 486.66 486.66 0.00
917G Invoice Multiple | Baylor Plano 979.67 979.67 0.00

9HTIE Estes, Glen (Baylor Plano)

Totals 1,499.89 0.00

SearchBy w Date: o

Unapplied Amount 0.00

I Rollup transactions for sub-accounts I

[T] Print receipt

URA West Palm Fall'20

Diamond Data Systems, Inc.
What’s New in The Uniform Solution =

16

10/3/2016

16



New Features v6.05 & BavonD

CONMNECTING FEQPLE WITH TECHNOLOGY

» Sales Entry Search and Receipt Barcodes

Setup > Store > Messages > Receipt Options > 7T WD
Print a barcode for the reference number on receipt '

Uniforms USA
- e
4 AUtO—Start POI I | ng * (972)25-2800

waw . Lni Tormsusa. com

Transact ion  Special Order
Clerk Clerk
Est Delivery 09/23/2016

[T sales Entry Search EI@

Sold To heet Mo, 58
1. Search
Renee Culbreath
Search Options 1405 Timber!|ine Dr
Richardson, Tx 75080
RefNo: 0123 Q, Search By: | Ref No. [=] (972)422-9168
Resufts Otvrtte e nourt
140 00119883 27.50 27.50
Ref MNo. Date Sold To Balance Tatal 3 PCH-8705-CRBK-M * Pant
w
Total 29.77
Received 24.90
Balance 4.87
Date Payment Amount
09/15/16  Cash 24.90
Seecial Orders must be picked up within
[ Show quantities 10 days of receipt
[ = Fa-£ait ] [ @ Fa-DeliverAdj l [ . F9-Print ] [ 9 F10-Clear ”""lll Il"
012

3

Diamond Data Systems, Inc.
What’s New in The Uniform Solution =
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New Features v6.05 & DAXohR

CONMNECTING FEQPLE WITH TECHNOLOGY

» WebStore

» ChargeltPro Secure Credit Card Processing ?—% ChargeltPro
» X-Gift Cards from OpenEdge (ChargeltPro Gift Cards Coming)

W biAMOND
—

DATASYSTEMS

Uniforms for Dallas / Fort Worth = =

Sign Out bmc@gmail.com | Group Sign In | My Cart (1 ltems, $29.00)

Home Shop Best Sellers My Account Contact Us

Checkout Step 2 of 3 - Billing Information Cart Summary Show Details
1 ltem $29.00
Order Total: $31.39 In-Store Pickup $0.00
Tax 8.25% $2.39
Gift Card: | Redeem a Gift Card | I K
Total Cost of this Order $31.39

Billing Options: CIETILLE
Pay for the entire order now Payments to Submit
Billing PO Number: [ ] Bill Me 50.00
Credit Card 3139
Billing Terms: Credit Limit: 2,500.00 Available: 2,500.00 redtbar §

Amount to Bill: (Max $2,500.00) Pickup Address

Uniforms USA
2100 Republic Drive
Dallas, TX 75081

% Ny Billing Address is the same as my Shipping Address

Diamond Data Systems, Inc.
What’s New in The Uniform Solution

URA West Palm Fall 20 l_THEUNIFORM
ASOLUTION
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New Features v6.05 ¥ DANOND

CONMNECTING FEQPLE WITH TECHNOLOGY

» WebStore

» Specify Order Type (Sale or Special Order)

» Customer Order Type Override
(Customer Form > WebStore > Billing Tab)

f Changing Customer (Baylor Plano) Acct Me. 57 Billed Te (Baylor Texas)

[1 General "2 Nmes"g Billing \nformatmn"g Sales &Taxes"ﬁ Ship Ta Mg Credit Card & Contact| 7. WebStore |8 Log

=)= =
m Logs | Billing
Override WebStore Order Type WebStore Linking Options

WebStore Order Type: Use Default n Allow customers to link to this account
WebStore Billing Options Expires UGN |
Allow WehbStore purchases to be billed Group Name: paylor
Start 10115 @\ Password: 1233
End: 10117 @ (not required) [T Require email approval of sub-accounts (most secure)

Allow sub-accounts to Bill from the WebStore

Start W5 &
End: W7 &8 (not required) Billing Limits (added to the profile of new sub-accounts)
[7] sub-accounts can bill invoices as a store charge Type Credit Limit Iz‘
Sub-accounts can bill invoices as payroll deduct Amount 250.00 |
Win Periods 1B Max Periods: 4 [
SelectImage
[] Set inactive

URA West Palm Fall'20 I
Diamond Data Systems, Inc.

What’s New in The Uniform Solution -I 19
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Pending Features R S

» Desktop

o Multi-Tender Returns

[ Payment Screen (Refunding by a Single Payment) o] ® [
Total Due Paid Out Due
-43.30 43.30 0.00
Refund
o L%
[ Cancel l

URA West Palm Fall 20 l_THEU NIFORM
PR 1 AMSOLUTION
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Pending Features

» Desktop

> Texting with Twilio
+ Individual Texts
+ Order is Ready
- Tagged customers

L) d
WV‘J DATA SYSTEMS

ili Send Text Messages

Select criteria for customer list

Tagged customers
Special Orders ready for delivery

E Send Text Messages (Special Orders ready for delivery)

Lo o]

Text message to send

Customer send list

Your order is ready. Please come to Uniforms USAto pick itup.

Send Text
Previous
Tag Options w

« Tag-UnTag

Tagged: 3

i

. FO9-Print List

T Custormer

Burger, Blake

Phone Number

(972)385-3257

URA West Palm Fall'20
Diamond Data Systems, Inc.
What’s New in The Uniform Solution

" Duckett, Paul (972)391-3688

v Plano Surgery Center (972)423-8594
11: THEUNIFORM
=9OLUTION

10/3/2016
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Pending Features s BIENGNE

» Desktop
> Your Proficiency (Feature Utilization Analysis)
> File > My Proficiency

E My Proficiency (Feature Utilization Anaylis) = @

Expand All
Overall Proficiency Score: 54 %

ContractAll
[=} [ Desktop (14/29) (48%) i
El— v Purchase Order (3/5) (60%) = ‘ FO-Print

»* Purchase Orders (2)

x
" Auto create purchase orders (1)

¥ PO's leftin Working On status (1)

[+F 1 Inventory (3/4) (75%)

[=F - sales (3110) (30%)

' Special orders (1)

¥ Special orders delivered (1)

" Contracts (1) i

Description
Issue purchase orders directly to vendors utlizing EDI

Utilization

Consider using EDI for purchase orders. Using EDI for purchase orders
will improve accuracy and speed since it transmits the order directly to
the vendor.

URA West Palm Fall'20
Diamond Data Systems, Inc.
What’s New in The Uniform Solution =
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CONMNECTING FEQPLE WITH TECHNOLOGY

Pending Features Ae DAVIGND

» WebStore

> Modern Look and Feel Lﬁg*ggﬁlg?gﬁ e >

> Responsive Design Reats & Detr
M Works on Desktop Home LeftShop Shop  BestSellers My Account  ContactUs  Resources
- Works on Mobile Devices

Welcome to The Uniform Solution’s On-line Store!

We are glad you have selected to visit our on-line WebStore, Here you will find the same great selections you can find in our retail store,

We hepe you enjoy your shopping experience, and please come by our retail store - we would love to see you,

If you have already established on-line access 1o our WebStore, select the “Sign in” aption at the top 1o review your purchase and order

history. You can even re-print a receipt if you like. If you are new 1o the WebStore but have made purchases in our retail store and have a

you can create an on-ling ID that is linked to your existing account. Just select the “Sign in” option and choose “Link to My

Account”.

THEUNIFOR
SOLUTIO

1] N

Empawsring Uniform
Retailars & Daalers

[T THEUNIFORM

LESNTEH

Empowering Uniform
Retallers & Dealers

Welcome to The Uniform
Solution's On-line Store!

We are glad you have selected 10 visit our on-
line WebStore. Here you will find the same
great selections you can find in our retail
store. We hope you enjoy your shopging

perience, and please come by our retall
store - we would love 1o see you

I yeaus have already established on-line access

URA West B oo Wt et o Bkl P ITHEUNIFORM
=SOLU N

Diamond Data SyStemS, Inc. history. You ean aven re-print & receipt if you
What’s New in The Uniform Solution
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Coming Features Afx DayOND
» Signature Capture for Sales Entry
» Brands for Inventory ltems

» Reward Program

CnargeltFro

7 Changing Reward Program

Seftings

Reward Program is Active Today

IIB
4
H

Start Date: 10116 =@ Cancel

End Date: =

Enrollment

Automatically enroll new customers in rewards program

Promptte enroll customers not in the rewards program in sales entry

Earnings
Issue a Reward each time total net sales reaches: $100.00
Reward Type: Fixed Amount lz‘
Amount: $5.00
Reward is Active in how many Days: 14 [=
Reward Expires 1year lz‘

Infarm clerk in sales entry when rewards are earned

What’s New in The Uniform Solution

URA West Palm Fall 20 _THEUNIFORM
Diamond Data Systems, Inc. S L U N
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Diamond Data Systems, Inc.
What’s New in The Uniform Solution

CONMNECTING FEQPLE WITH TECHNOLOGY

Programming Team 2 5nise

Larry Sand
Loves assembly code, writing classes, and a prolific reader on new technology
29 years of development experience
Eddie Sizemore
The coonhound of programmers, interface guru, installer developer, etc..
27 years of development experience
Paul Sink
27 years of development experience
Honey Baked Ham key developer of their Corporate POS System for 15 years
Dave Harms
CoveComm Consulting, Clarion Magazine (Editor, Creator, and Contributor)
24 years of professional development experience
Mike Hansen

Boxsoft Development and Consulting - 28 year Developer of programming tools with an
emphasis in Ul design and user productivity - 32 years total development experience

David Johnson

Ul, workflow, and architecture expertise with 23 Years in POS development
26 years of professional development experience starting with Andersen Consulting in 1990

URA West Palm Fall 20 mTHEUNIFORM

SOLUTION
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Diamond Data Systems o 3ae
o y W? iy, DN OND
I nve Stl 1 g N YO ur TO m 0 I’I’OW |l e = e

1992 - The Uniform Solution for DOS

2001 - The Uniform Solution for Windows

2003 to 2014 - EDI, ASN Receiving, VStock, Vendor Images

2011 - The WebStore and Web Server Technology

2014 - SQL Server

2014 to 2015 - iOS and Android apps for employees

2016 to 2017 - 6.01 to 6.05 Features, Responsive WebStore, etc.

v Vv Vv Vv v Vv v

Total Annual R&D Budget (Programming and Training > $1M/year)

URA West Palm Fall 20 I"-THEU NIFORM
What's New in Th& Uniform Soluron ASOLUTION
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What’s New

Question and Answer
Guardians of the Galaxy Post Credits
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